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Question

This article originates from the Siemens Industry Online Support. The terms of use
specified there apply (www.siemens.com/terms_of use).

The following link takes you directly to the download page for this document.
http://support.automation.siemens.com/WW /view/de/65128501

Caution

The functions and solutions described in this article are limited primarily to the
implementation of the automation task. Please also note that in case of networking
your plant/system area with other parts of the plant, the company network or the
Internet, appropriate protective measures within the framework of industrial security
must be adopted. For more information, see the entry ID 50203404.

http://support.automation.siemens.com/WW/view/de/50203404

Question

Contrary to using Safely Limited Position (SLP) via TM54F, for control via
PROFIsafe there is no retraction routine saved in the drive. How can retraction be
implemented using a fail-safe control and PROFIsafe communication?

Answer

To fully answer this question, follow the handling instructions and notes listed in
this document.

Fail-safe Retraction
V1.0, Entry ID: 65128501


http://www.siemens.com/nutzungsbedingungen
http://support.automation.siemens.com/WW/view/de/65128501
http://support.automation.siemens.com/WW/view/de/50203404

Table of contents

Table of contents

1

Fail-safe Retraction

14 o T 11T 4 o o 4
1.1 LT3 ST 4
1.2 PreCoNitioNS. ... .. couiiiii e 4
Description Of DIOCK .........eeeeeeeeeeeeeeeeeeeennne s 5
21 Principle of operation...........ccccoovvveiei 5
2.2 SHTUCKUIE. ... 7
2.3 Implementation in the program...............cooooiiiii e, 9
24 Parameterizing the safety functions in the drive ............................... 17
2.5 FUNCHON TEST. .. e e 20
L [T o T/ 22
L0071 7= o2 7= = o ) T 23

V1.0, Entry ID: 65128501 3



1 Introduction

1.1

1.2

Introduction
Task

A traversing range in which a drive moves is to be monitored using the SLP safety
function (Safety Limited Position). If the permissible traversing range is exceeded,
then the configured stop response is initiated and the drive comes to a standstill.
Due to the fact that the range has been violated, safety messages C01715 and
C30715 with fault values 10 or 20 (limit switch pair 1 or 2) are output. SLP must be
deselected in order to be able to acknowledge these messages. However, as a
consequence, an unsafe state is created. This is because the operator can now
continue to move into the inadmissible range. This is why a logic function should be
programmed, which prevents traversing to be continued into an impermissible
range, therefore guaranteeing that the safe state is maintained.

Preconditions

This block can only be used in conjunction with a SINAMICS S120 and firmware
V4.5 or higher. The basic precondition is that a fail-safe control system (e.g. S7
CPU315F-2 PN/DP) is used together with PROFIsafe telegram 31, 901 or 902.

Fail-safe Retraction
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2 Description of block

Note

Description of block

Principle of operation

This block is used to retract a drive via PROFIsafe after a safe traversing range
defined using the Safety Limited Position function (SLP) has been violated.

After selecting the SLP safety function, a configurable traversing range is safely
monitored. If the upper or lower limit of this traversing range is violated, the
parameterized stop response is initiated, and the corresponding safety messages
are output. SLP must be deselected in order to acknowledge these fault messages;
this means that an unsafe state would be created, as the drive can continue to
traverse/move into the inadmissible range. Retraction logic is used in order to avoid
this happening.

As an alternative to programming retraction logic, a wider traversing range can
be selected (using bit 19 in the PROFIsafe STW2). As a consequence, the safety
messages can also be acknowledged and the drive can be subsequently
traversed.

This FAQ concentrates on programming retraction logic; switching over the
traversing range is not discussed here.

The principle of this block is shown in the following diagram:

s A
I Retraction
. ‘ SLP .
SLP selection i decalaction SLP selection
' sDI
| | | SDI selection I dectiaction
| I i
sDl
SLP SLP
Sx_u l
| 1) | | 2)
| I .
_ L |
| L |
sx_| ;
| se 1| \ stp
| S |
|

1) Stop response initiated
2) Traverse the drive back to the permissible range

In this case, the traversing range of SLP is considered between the software limit
switches Sx_| (lower software limit switch) and Sx_u (upper software limit switch). In

Fail-safe Retraction
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2 Description of block

Note

Note

this example, the upper SLP limit is exceeded, and the parameterized stop
response initiated. SLP must be deselected and SDI selected to be able to retract
back into the permissible traversing range. The SDI direction to be selected
depends on the violated SLP limit — if the lower SLP limit is violated, then SDI+ must
be selected, and when the upper SLP limit is violated, then SDI-.

SLP is deselected and SDI selected in the same cycle and in the same
PROFIsafe telegram. This guarantees that a safety function (SLP or SDI) is
always active.

When activating the retraction logic, SLP is deselected so that the safety messages
can be safely acknowledged. SDI is selected in the same cycle, in order to prevent
the drive (axis) traversing beyond the limit switch. The drive can then be traversed in
the permissible range.

If the drive would now be further traversed into the inadmissible range, then after
exceeding the SDI tolerance (p9364/p9564), the parameterized stop response of
SDI would be initiated.

In order to ensure that the drive does not traverse into the permissible range for an
arbitrary time, and could possibly pass (actuate) the second limit switch of the
traversing range, this block has a safe timer. After selecting retraction, this timer is
started — and after a retraction time, configured by the user, the timer is stopped. If
the drive is still not in the permissible traversing range after this time has expired,
then retraction must be reselected, the safety messages safely acknowledged and
the drive traversed into the permissible traversing range.

Fail-safe Retraction
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2 Description of block

2.2 Structure

The signals of the block and their interconnection are discussed in the following.

Fig 2-1 Block structure
LEZ7E

FRZ7Z
"Betraction"

— EN

SLP_
—{s2lection

SLE_
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—{limit

SLP_
lower
—{limit
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negative SLP
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retractio direction
-

DI _neg
time for  direction
retractio
- ENO

Table 2-1 Interconnecting the inputs

Inputs Data type Description of the interconnection
SLP_selection BOOL Signal used to select SLP.
. The user must interconnect the signal with
SLP_upper_limit BOOL PROFIsafe-ZSW2 bit 30 ("SLP_P_ ok").
. The user must interconnect the signal with
SLP_lower_limit BOOL PROFlsafe_ZSW2 bit 31 ("SLP_N_ok").
The user must interconnect the signal with
safely_homed BOOL PROFlsafe_ZSW2 bit 23 ("SP ref").
SDI_positive_selection BOOL Signal used to select SDI+.
SDI_negative_selection BOOL Signal used to select SDI-.
retraction BOOL Signal used to select retraction ("high"

signal). After violation of a position range

Fail-safe Retraction
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2 Description of block

Note

Inputs Data type Description of the interconnection

and a positive edge at "retraction", the axis
can be retracted back into the permissible
range.

A time is entered here, which specifies how
long the retraction logic is active. After this
time expires, SLP is reselected and SDI is
time_for_retraction TIME deselected. This prevents the drive from
traversing out of the permissible position
range, past the second software limit

switch.
Table 2-2 Interconnecting the outputs
Outputs Data type Description of the interconnection
SLP BOOL gr;fs F?lgtg;tl Srz‘;J:tS tfre\zl\i/r;t.erconnected with bit
SDI_pos_direction BOOL Igizfo;g)ou:: T;;fs(; tée_lz_\i/r:/tze.rconnected with bit
SDI_neg_direction BOOL Igizfo;g)ou:: T;;fs(; tée_lz_\i/r:/tze.rconnected with bit

Fail-safe signals are used to select SLP, SDI+, SDI- and retract (SLP_selection,
SDI_positive_selection, SDI_negative_selection and retraction). If SDI is only used
for retraction, then the SDI_positive_selection and SDI_negative_selection signals
must be interconnected with a fail-safe “high”-signal.

The user specifies an activation time for retraction (time_for_retraction). The time
depends on the particular application.

The retraction time must be selected, so that when retracting with the maximum
velocity, the second software limit switch cannot be passed.

The upper and lower SLP limit (SLP_upper_limit and SLP_lower_limit) is
interconnected with bits 30 or 31 of PROFIsafe-ZSW2.

Input "safely_homed" is used to interrogate as to whether the drive has been safely
homed. The user must interconnect this signal with bit 23 of PROFIsafe ZSW2.

The output signals for SLP, SDI+ and SDI- (SLP, SDI_pos_direction and
SDI_neg_direction) are interconnected with PROFIsafe STW2.

Fail-safe Retraction
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2 Description of block

2.3 Implementation in the program

This chapter explains how to commission the block.

Table 2-3 Description on how to commission the block

No.

Action

Remark

First open the SIMATIC
Manager.

‘e
ad

Then unzip the zip file
associated with this FAQ.
To do this, click on "File >
Retrieve...".

‘File PLC View Options Window Help
New... Ctr+N
‘New Project' Wizard...
Open... Ctr+0

S7 Memory Card
Memory Card File
Delete...
Reorganize...
Manage...
Archive

Fage Setup,

1WS_Safety2012_Uebung] (Project] - D:\WS_Saf_1
2 Distributed Safety (V1)

3 Retraction_for_SLP (Library) - D:\Retract

4 121153_Spindel_Musterabn (Project) -- D:\121153_1

Exit Alt+Fd

v v

Now select the directory in
which the zip file is saved and
then open this.

Retrieving - Select an archive 2] x]
Lack in: | ) Freifahtiogik 5] « @ ok E-

18] lib_Rietraction_for_5LP.zip

. [+]

File name: IIib_F|etraction_for_SLF'.zip Open I
Files of type: IPKZip12.4-Arc:hive [.zip) j Cancel |

-

Now select the target path
under which the unzipped
files should be saved.

Select destination directory
E--@ Desktop j

ElH by Computer

- B3 My Documents
ﬁ Shared Documents
&g WINDOWS [C:)

=R DATA (D)

(] I Cancel Help

Fail-safe Retraction
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2 Description of block

10

No.

Action

Remark

Here, you are prompted as to
whether you wish to open the
library. Click on "No".

-

Retrieve [3280:754)

The following objects were retrieved:
Projects: None

Libraries: Retraction_for_SLP

Do you want to open these now?

Yes

No

[MyProject

Bp File Edit Insst PLC Wiew Options Window Help

D807 & e dal[o &= )= [[<HoFi=r> HY BEEREMN
MyProject | Dbject name | Symbolic name | Createdin language | Sizein the work me... | Type
SIMATIC 300(1] 59 Systemndaten - - 50B
CPU 315F-2 PN/DP o081 38 Organization Block
B+ ST-Programmil] £ 0B35 CYC_INTS 52 Organization Block
g s:j!:ne 0882 I/O_FLT1 98 Organization Black
= 0883 140 FLT2 38 Drgsrizstion Blck
W S120CUZBOPCEED £ 0B85 OBML_FLT 38 Organization Block
= oBse RACK_FLT 30 Organizstion Black
= 0B&7 COMM_FLT 38 Drgsrizstion Block
=012 FROG_ERR 38 Drgarization Block

o 0B122 MOD_ERR

5 FE213 F_ACK_GL

&3 FEG F_I0_CGP
53 FE163 F_CTALY

3 FE1640 FCTAL 2

& FEN642 F_DIBG_N

&3 FCl

53 081

&+ DB219

@ 08272

3 DBs1a F_GLOBDE

&+ DBE1a FODDOD_FDI24:0C28Y FDB
&3 DBs20 FODNO_FDOSOC2NV 24 FDB
3 DBS21 FODDES_PROFlsafe_Telear  F-DB
et 1 VATl

&3 5FC1e DPRD_DAT STL
53 S5FCI5 DPWR_DAT STL
&% 5FC41 DIS_AIRT 5TL
&3 orca2 EN_AIRT STL
53 5FCeB sTP STL
&% SFCS1 RDSYSESET STL

Open your project so that you can use the library block.

Organization Black.

Function Block.

15744 Function Block
9334 Function Block.
6852 Function Block.

984 Function Block
38 Function
36 Instance data block
38 Instance data block. .
48 Instance dats black
314 Data Block
BB4  Instance data block...
EB4  Instance data block ..
EB4  Instance data block.
- Variable Table
Spstern function
System function
System function
Spstern function
System function
System function

Fail-safe Retraction
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2 Description of block

No.

Action

Remark

M KOP/AWL/FUP - [FB1 -- Default\SIMATIC 300(1)\CPU 315F-2 PN/DP]
< - Datei Bearbeiten Einfugen Zielsystem Test Ansicht Extras Fenster Hilfe

DEEH|&E & BE|v o |6idal® | <0 |mE| e k) E =

ﬂi‘ Inhalt von: 'Ungebung
= & Schnittstelle [Name
P Neues Netzwerk O v 1N
#-(&) Bitverkniipfung O out 1 OUT
(] Vergleicher O 1H_oUT 3 IN_OUT
#-{ag Umwandler B STAT @ STAT
® DB-Aufruf & TENP {&@ TEMP
#-{g] Springe
#-z0) Festpunkt-Fkt.
#-{3] Verschieben
@6 Programmsteuerung
[)-{@iz) Statusbits : Titel:
(25 Wortverkniipfung -
& @ FB Bausteine start adress of PROFIsafe-STWZ: 15
#-{gl FC Bausteine
4l Multinstanzen DE272
=¥ Bibliotheken pe——
-G Distributed Safety (V1) “Retraction®
- Retraction
E-{gg S7-Programm(1 —{EN
SLP
ED.Q = sel;ction
SLP
upp;:_
E18.6 == limit
SLP
low;r
E18.7 = .I.im:i.t_
safely
E17.7 =={homed -
SDI_
positive
EOQ. 1 — selectio;
SDI
neg;t:i.ve_ SLPl-p15.6
ED.2 —{selection
SDI_pos_
retractio directionf-31¢.4
ED.3 =
SDI_negy_
time_for directionfeplg_ &
retr;ct.i;
T#5S =t ENO |-

Now open the block in which the safety program is created. In this particular

example, FB1 was used.

As can be seen in the diagram, you can find the library block under "Libraries >
Retraction_for_SLP > Retraction > FB272 Retraction".

Drag this block and drop it into your safety program.

Fail-safe Retraction
V1.0, Entry ID: 65128501
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2 Description of block

12

No. Action Remark
start adress of PROFIsafe-STWZ2: 15
1 ) DB272
FB272
"fetraccion"
2). e
SLP_
E0D.0 —selection
SLP_
upper_
E1lS.6 =4 limit
SLP_
lower
E1l8. 7 = limit
safely
E17.7 —honed
SDI_
positive_
EQ.]l —selection 3)
SDI_
8. negative_ SLPAa15.6
EQ.Z —Hselection
SDI_pos_
retractio directionllils.4
ED.3 =
SDI_neqg_
time_for_  directionidalée. s
retractio
TH#S5S =2 ENO |

In the next step (1) the block is assigned an instance DB. DB272 was used in this
example.

In the next step (2), the input signals are interconnected. Fail-safe sensors are
used to select SLP, SDI+, SDI- and retract (SLP_selection, SDI_positive_selection,
SDI_negative_selection and retraction). If SDI is not separately used, then the
SDI_positive_selection and SDI_negative_selection signals must be
interconnected with a fail-safe “high”-signal.

The user specifies an activation time for retraction (time_for_retraction), for
example 5 seconds. The time depends on the particular application.

The upper and lower SLP limit (SLP_upper_limit and SLP_lower_limit) is
interconnected with bits 30 or 31 of PROFIsafe-ZSW2.

Safe homing (safely_homed) is interconnected with bit 23 of PROFIsafe-ZSW2.

In the last step (3), the output signals for SLP, SDI+ and SDI- (SLP,
SDI_pos_direction and SDI_neg_direction) are interconnected with PROFlsafe
STW2.

Fail-safe Retraction
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2 Description of block

No. Action Remark
Now save your Safety
program.
If you have already
implemented the safe timer
9. | FB186 in your block =]
container, then you can
continue with line 17 -
otherwise, continue with the
next line.
To insert the safe timer 2 SIMATIC Manager - [MyProject -- D:\MyProjec]
FB186, first click in the % Edit Insett PLC View Option: ‘“window Help
SIMATIC Manager on the E Mew. CtrkeN
"File > Open..." button. B "Mew Project’ Wizard...
Opet... Cirl+0
Cloze
ultiproject 3
57 Memom Card 3
temory Card File 3
Save bz Ctr+5
Delete. ..
10. Rearganize...
Manage...
Archive...
Retrieve...
Frint 3
Page Setup...
1 WS Safetn2012_Uebungl [Project] - D:AWS_Saf 1
2 Distributed Safety 1)
3 Retraction_for_SLP [Library] - D:%\Retract
4121153_Spindel_Musterabn [Project] -- D:A1 211531
E =it Al+Fd
Then, under libraries (1) Open P"’i“ e
select the "Distributed Safety - — . —
. User project Ihb'alm |I5ample projects | Multiprojects
(V1)" library from (2). l I
aEE | Storage path 2|
= C:\Program Files\Siemens\Step7\S7libsh
N Distributed Safety (W1]  C:\Program Files\Siemens\Step7\S7libs
(R Frenahien D-\Frefa_1
S Freitahrt_und_STw D:\Freifahr
& lib_retraction_20120911  D:\lib_retr
@ lib_v45_alle_Funktionen D:\ib_v4_2
11. @Ilb_V45_a1Ie_Funklinnen D:\ib_V4_1
Lk S 7AR alla Cimabbimmam  DALR VAR =
T | i
Selected
User projects:
Libraries: 1
Sample projects:
Multiprojects: Browse...
cocel | Hep |
%
‘SIMATIE M anager - [Distributed 5afety [V1] -
@ File Edit Inset PLC “iew Options ‘Window Help
DB EE = = ENG
12. - Distributed Safety 1] Object name Symbaolic name Tupe
spplication Blo 57 Program
F-System Blocks 57 Program
The library now opens. Click on "F-Application Blocks".

Fail-safe Retraction
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2 Description of block

14

No.
@ File Edit Insert PLC “iew Options ‘window Help
D |8%F | & B o =% & & =) R B
E@ Distributed Safety 1) Object name | Symbolic name | Tupe
13. F-Appllcatlon.Blocks (Bl Source Files Source Folder
Bl Source Files T Bloc < Folder Offine
8 Blocks &) Sumbole Symbal table
F-System Blocks
Open the "Blocks" folder.
JL. SIMATIC Manager - [Distributed Safety (¥1) - C:\Program Files\Siemens\StepZ\57libs\Distributed Safety (¥1]]
@ Fie Edit Insst PLC View Options Window Help
O 8% =2 2= <o Fiter> AN EEE ssme
-2 Distrbuled Safety [¥1] Object name | Symboiic name [ Createdin language | Size inthe work me... | Tupe
=) Féipplication Blocks 3 FB173 FsCal F5TL 150 Function Block
(@] Source Files 53 FR181 FCTu F5TL 114 Function Block
~ 28 Blacks S FeTEz FoTo F5TL 114 Function Block
(311 F-System Blocks 3 Fena: F_CTUD FSTL 200 Funclion Black.
&% FB124 F_TP F-STL 292 Function Block
53 FB185 F_TON FSTL 10 Function Black.
prms T ark 0P Erey Open Obiect Chiletit+0 F
SHFEISE F_ZHAND FSTL Cut Chie
G FE18Y F_MUTING FSTL
S FE190 F_100201 L Faste Gilr:
53 FB211 F_2H_EN FSTL
14. 3 Foziz F_MUT_P FSTL Delete Del
3 FE2IE F_ESTOP1 FFED Insert New Object »
S FE2IE F_FDBACK FFED
GHFE217 F_SFDOOR F-FED Compars Blacks..
S FE219 F_ACK_GL L Fiint »
3 FB223 F_SENDDP FSTL
3 Fa2ze F_RCVDP F5TL ISET 72
53 FR225 F SENDST FSTL Object Properties... Al+Retum
53 FRozs F:HEVS? ESTL Special Object Propertiss 3
GHFCI74 FSHL W FSTL 52 Function
SFC75 F_SHR W FSTL 52 Function
SHFC176 F_BO_W FSTL 174 Function
S3FCI77 F_w_BO F5TL 174 Function
SFCI7E F_INT_wR FSTL 276 Function
SFCI7S F_INT_RD FSTL 276 Function
Now copy block FB186. To do this right click in the block container and on "Copy".
JSIMATIC Manager - [Distributed Safetv V11 -- C:\Program Files\Siemens\Step7\S57libs\Distributed Safety (V1]]
¢ File Edit Inset PLC View Options| Window Help
D227 % @ ewWindon
- = 1ange »
=62 Distributed Safety (v1) | Dbject .
=-(z1] F-Application Blocks &3 Fe
(&) Source Files &3 Fel Minimize All
iz Blocks &3Fg1 CloseAl
] F-System Blocks e
Save Arrangement
& i:: Restore Arangement
1 MyProject -- D:\MyProjec
&3 FB1 v 2 Distributed Safety [V1) - C:\Program Files\Siemens\Step7\S7libs\Distributed Safety [¥1)
&3 FB188 F_2HAND F-STL 28
£+ FB189 F_MUTING F-STL 70
&+ FB1S0 F_1002D| F-STL 44
15. & Fe211 F_2H_EN F-STL 44
&3 FB212 F_MUT_P F-STL 102
&3 FB215 F_ESTOP1 F-FBD 33
&+ FB216 F_FDBACK F-FED 33
& Fe217 F_SFDOOR F-FED 34
&3 FB219 F_ACK_GL F-STL 3
&3 FB223 F_SENDDP F-STL 445
£ FB224 F_RCVDP F-STL 434
& FB225 F_SENDS? F-STL 973
&3 FB226 F_RCVS7 F-STL 765
&3 FC174 F_SHL_W F-STL 5
&FFC175 F_SHR_W F-STL 5
&+ FC176 F_BO_W F-STL 17
& FC177 F_w_BO F-STL 17
&+ FC178 F_INT_wWR F-STL 27
£FFC179 F_INT_RD F-STL 27

You can now change to your project using the "Window" button.

Fail-safe Retraction
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2 Description of block

No.

Action Remark

16.

PL;/ SIMATIC Manager - [MyPioject — D:\MyProjec]
2P Fle Edit Imset PLC Visw Options ‘Window Help

O |8y = e|e 2%

| ||<NoF|Ite|>

AW EEE B30

= MyProject Object hame | Symbolic name | Created in language | Size in the,
EE SIMATIC 20001) 59 5 ystemdaten -
=-[§] cPU 315F-2 PNADP o081
| B S7Frogiamml1) 0B CYEINTS sTL
! (&1 uellen o oes 1/0_FLT1 sTL
B swzn@ciggglezmgp CEE20 oess WO_FLTZ Sl
b i £ 0B85 DBNL_FLT sTL
£ 0BSE RACK_FLT STL
& 0BE7 COMM_FLT STL
08121 PROG_ERR sTL
o 0B122 MOD_ERR sTL
oHFE F Frogram FFED
SHFEZ1S F_ACK_GL FSTL
o FE272 retraction F-FED
&HFBIE3 F_I0_CGP FSTL
&HFBIE F_CTAL_T FSTL
EFEIED FCTAL_Z FSTL
EHFEIES: F_DI&G_N FSTL
=an] F-CALL
&3 DB1 F-DB
&FDE213 FDB
o DB272 FDE
&3 DESIS F_GLOEDB FDE
SEETS FOO000 POl aDCody FOE
&3 DBe20 FOODT0_FDOB:DC24Y_24  FOB
&3 DS FOODE4_PROFlsafe_Telegr  FDB
et 1 VaT_1
HSFCI4 DPRD_DAT STL
&35FCIS DPwRA_DAT STL
&3 5FCa DIS_AIRT STL
&3 sFC4z EN_AIRT sTL
&3 SFC4E STF 7L
& SFCE RDSYEST STL
ik
Eifs0
Delete D)
Insert Mew Dbject »
FLC 3
Rewie...
Compare Blocks..
Reference Data 5
Check Block Consistency
Print 3
Object Propetties Alb+Rstun
Special Object Propertiss 3

Now insert block FB186 into the block container of your project. To do this right
click in the block container and on "Paste".

17.

I/ SIMATIC Manager - [MyProject - D:\MyProjec]
£P Fle Edt Inset PLC View Options ‘Window Help

D@ 8% % 0 e o %% =

&5 | & [[<NoFiter> % %8 @

]

B MyProject Object name | Symbolic name | Created in language | Siz¢
SIMATIC 300(1) |@5ys,emdalen
CPU 315F-2 PN/DP o0t

E-n S7-Programm(1) 0835 CYC_INTS STL
g g:i::ﬁ o osR 1/0_FLT1 STL
L o oge3 1/0_FLT2 STL
® E S120xCU320x2xDPxCBE20 £ 0BS5S 0BNL_FLT STL
3 0Bes RACK_FLT STL
{30887 COMM_FLT STL
4 oe121 PROG_ERR STL
£ oe122 MOD_ERR STL

{3FB1 F-Program F-FBD

&F FB186 F_TOF F-STL

&+ FB213 F_ACK_GL F-STL

3 FB272 Retraction F-FBD

To generate the safety program, click on this button marked red.

Fail-safe Retraction
V1.0, Entry ID: 65128501
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No. Action Remark
=74 Safety Program - MyProject\SIMATIC 300(1)\CPU 315F-2 PN/DP\S7-Programm{1)
=1+ Safely program
@) Feruntime group FC1
18.

First press the "Compile" button to generate the safety program (1). The safety
program is then downloaded by pressing the "Download" button in the fail-safe

control (2).

Fail-safe Retraction
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24 Parameterizing the safety functions in the drive
Table 2-4 Parameterizing the safety functions
No. Action Remark
First open STARTER, then
your project and go online. EmR'
1.
7|
STARTER
TSN SN SN NN Y
Safety Integrated
Safety function selection
IF‘(-;- safety function ;I
2.
| Change settings I (hange passord |
Click in the "Safety Integrated" screen form on "Change settings".
2L 2 9 9 9 9 999999999 99 WS
Safety Integrated
S afety function selection
Mo zafety function j
Mo zafety function
Bazic functiohs via onboard terminals
Basic functions via PROF]zafe
3 Bazic functions via PROFIzafe and onboard terminal
’ Extended functions via TMB4F
E stended functi ia PROF|zafe
Extended functions via TMB4F and bagic functions via onboard terminals
Extended functions wia PROF|zafe and basic functiohs via onboard terminals
Extended functions without zelection
Estended functions without zelection and bazic functions via onboard terminalz
In the drop-down menu, select the control type "Extended functions via
PROFlsafe".

Fail-safe Retraction
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No. Action Remark
AL S 2NN N NN YNN8
~ Safety Integrated | Safely checksums |
\ Safety function selection
| Estended functions via PROFIsafe

: I[D] Safety with encoder and accel_monitoring[SAM) / delay time
\ Configuration |
: Motion monitoring

Safe basic functions
\ (STOD. SBC)
~ Safe stop functions
\ (551,552, 503, SAM)

4.

~ 1 ) Safely limited speed
\ Safely functions (SLS)
\ IEnabIe _||

Safe speed monitoring
\ (SSM)
~ S afe motion direction
\ (5DN)
~ 2 ’ Safe position monitoring
~ [SLP. 5P)
: Acceptance mode |
Then enable the safety functions (1) and select the screen form "Safe position
monitoring (2).
A SSR N NS ST TS SsSsSSTS ST SSNCNN NNV
: o | Position moritoring |

| |
I Enable x I— — 2
\ pl;_‘ :I Trav. distance
\ min max
5. \ P min in mm Pmax inmm Stop reaction

\ Position range 1 ||-1100.000 [1300.000 [21sTopc )
\ Position range 2 ||-‘|5EID.EIEIEI I‘ISDD‘EIDU |[2] STOPC vI
h

First enable the SLP function, and then define the traversing range to be monitored
(position range 1). In this example, a traversing range of between -1100mm and
+1300mm should be monitored. Stop response STOP C should be initiated if this
traversing range is violated.

Fail-safe Retraction
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No. Action Remark
A S SN NN NN YN YN YN NN NN
Safety Integrated | Safety checksums ]
Salety function selection
I Extended functions via PROFlsafe

I[D] Safety with encoder and accel_monitoring[SAM) / delay time

Configuration |

Motion monitoring

Safe basic functions
(STO, SBC)

Safe stop functions
(551,552, 505, SAM)

Safely limited speed
Safety functions [SLS)

|Enable j—

Safe speed monitoring

Safe motion direction
(SD1)

Safe position monitoring
[SLP, SP)

Acceptance mode |

2
T T TV T T T IV T T VTSNS

The safety function SDI is also required for the retraction logic. Therefore, select
the "Safe motion direction (SDI)".

Safe direction of motion

Safe directionofmotion |
ASCSSSSssSSNNNNNNNN SN

\ SDI
\ Enable I | Monitoring
\ O For positive direction
\ Delay time (D) Fornegative drection
7. selection SDI --> SDI active L
\ | 100.00 ms Tolerance
\ T ol |12.DUD mm
4]
\ Stop reaction ]
\ [1)STOPB -

Safety function SDI is enabled here.

Then click on "Copy
parameters® (1) followed by 1 \ Copy parameters |
8 "Activate settings" (2). 7

2) Activate settings |

Then copy RAM to ROM and .;I
carry out a power-on reset.

Fail-safe Retraction
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2.5

20

No. Action

Remark

Now load your project into the

10. PG and then save it.

@ o

11. | The drive must then be safely homed!

Function test

Table 2-5 Function test of the block

Execution Expected response Result
OKI/
error
Initial status

The safety functions SLP (Safely
Limited Position) and SDI (Safe
Direction) are enabled.

9501.1=1 and p9501.17=1.

The drive is homed and safely
homed.

r9723.17=1 and r9722.23=1.
The "Safely_homed" bit has a
value of "1".

Test

Select SLP

Select the "SLP_selection” input.

The "SLP_selection" input and
the "SLP" output assume a value
of "0". SLP is selected.

Allow the drive to rotate in the
positive direction until the defined
SLP end position is reached.

The drive rotates.

After the SLP limit has been
exceeded, the drive remains
stationary with the configured stop
response of SLP. Error messages
are output.

The "SLP_upper_limit" bit
assumes a value of "0".

Error messages C01715(x0) and
C30715(x0) are output.
Additional error messages are
output, depending on the stop
response that has been
configured.

(x): Depending on the SLP
traversing range

x=1: Traversing range 1

x=2: Traversing range 2

Selecting retraction

Select the "retraction” input
(positive edge).

SLP is deselected and SDI
negative is selected.

The "SLP" output assumes a
value of "1" and the
"SDI_neg_direction" output, a
value of "0".

The retraction mode is active
until the "time_for_retraction”
time has expired.

Note:

The retraction mode is active until the "time for retraction" time has expired.

Fail-safe acknowledgment.

There are no longer any error
messages after fail-safe
acknowledgment.

The drive is now traversed in the

POSITIVE direction until the SDI

The drive rotates until the SDI
tolerance (p9564) is exceeded.

Fail-safe Retraction
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tolerance is violated.

The drive then remains
stationary (zero speed). Error
messages C01716 and C30716
are output. Additional error
messages are output, depending
on the stop response that has
been configured.

The SDI error messages must be
safely acknowledged. To do this,
deselect the retraction logic
(negative edge at "retraction”).

The "SLP" output assumes a
value of "0", the
"SDI_neg_direction" output, a
value of "1".

As a consequence, error
messages for SLP are output
again.

Fail-safe acknowledgment.

The error messages for SDI
disappear after fail-safe
acknowledgment.

Selecting retraction

Select the "retraction” input
(positive edge).

SLP is deselected and SDI
negative is selected.

The "SLP" output assumes a
value of "1" and the
"SDI_neg_direction" output, a
value of "0".

Fail-safe acknowledgment.

There are no longer any error
messages after fail-safe
acknowledgment.

Now traverse the drive in the
negative direction until the axis is
again located in the valid
traversing range.

The drive rotates.

If the drive is again in the
permissible traversing range after
the "time_for_retraction" time has
expired, then the "SLP" output
goes to "0" again, and the
"SDI_neg_direction " output goes
to "1" again.

SLP is selected and SDlI is again
deselected.

Note

This behavior is applicable for the negative direction!

Fail-safe Retraction
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History

Diagram 3-1 History

Version

Date

Change

V1.0

02/2013

First edition
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4 Contact person

Siemens AG

Industry

| DT MC PMA APC

Frauenauracher Str. 80

D-91056 Erlangen, Germany

Fax: +49 9131/98-1297

mailto: safety.team.motioncontrol.i-dt@siemens.com
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